DAUB Dynamic Brush

(To run, double click on the icon 'DAUB 1.5')
Features

DAUB is a Windows drawing program which has a unique and speedy approach to
putting your graphics ideas onto the screen. DAUB simulates a broad brush that is
controlled using the mouse, and offers many ways to vary the look of the brush
strokes that you draw. Also, the brush strokes may be extensively modified after you
have drawn them, in ways that allow the computer to do nearly all the work. Lines of
text may be incorporated in the graphic, using any installed font.

As may be seen by the features described below, DAUB is a superb illustrative
graphics tool, fully capable of complementing other software being used by the
professional artist. Artists will be glad to know that DAUB graphics may be saved to
disk as Encapsulated PostScript files ® which may then be imported into most of the
current major graphics packages. For educational or personal use, DAUB is able to
print to any printer supported by Windows 3.1.

The main features of DAUB are:

Brush size fully adjustable.
s / /

Brush orientation fully adjustable through 360 degrees. Orientations of
0 and 45 degrees respectively are illustrated below:

|

This results in calligraphy style brush strokes:

Variable orientation option, resulting in brush strokes of constant
thickness:



This is like using an ordinary round brush.

Over 16 million colours available for the brush, although these will be
approximated to an extent dependant on the capabilities of your
graphics hardware and printer.

Variable brush size and/or colour while drawing the brush stroke, in
accordance with variations in the path of the cursor. Sophisticated
and complex effects can be achieved quite easily.

Text lines for headings, captions etc. All installed fonts are available, and
TrueType @ font text may be italicised, scaled and rotated. All fonts may
be made bold and coloured with the full range of colour.

Selection of one or more drawn brush strokes for further manipulation, for
example, re-colouring or stretching. Every drawn stroke has a small
selection circle which is green if the stroke is selected and red if it is not
selected.

Edit features, namely Cut, Copy, Paste and Delete for any selected
object(s).

Positioning any selected object(s). Fine adjustment of position is also
available.

Scaling and rotation of any selected object(s), also with fine adjustment.
This may be done with no loss of detail.

Smoothing and/or curve fitting of the outlines of any selected object(s).

Automatic re-draw of any selected stroke(s) with specified alterations to
brush size, orientation and colour.

Automatic re-draw using path attributes. Varies brush size,
orientation and colour of any selected brush stroke(s), after they
have been drawn. Very sophisticated and complex effects may be
achieved by making different changes to brush strokes that have
already been re-drawn one or more times.

Saving and loading of complete drawings on your hard disk or floppy
disks using DAUB's own special format. E.g. doodle.dob

Saving of selected brush strokes to the Windows Clipboard for easy



transfer to other Windows applications.

Printing to any Windows 3.1 compatible printer, at the printer's
resolution. No jagged looking bitmaps here!

PostScript compatibility with commercially available graphics
packages.

System Requirements

DAUB should run on any IBM compatible machine (preferably 386 or above) running
Microsoft Windows version 3.1 or later. The graphics standard should be EGA or
better. At least 3 megabytes of RAM is recommended.

Also, the use of a 80x87 Math Co-processor will improve performance due to the
computational nature of the graphics manipulation. A further boost to performance
may be gained by installing a graphics accelerator card.

Treat yourself to a truly innovative product! DAUB Dynamic Brush.

(To order a registered copy, please use the form in the file order.txt - this can be done
via the Help menu)

(1) PostScript is a registered trademark of Aldus Corporation
(2) TrueType is a registered trademark of Apple Computer Inc.



Instructions

These instructions are based on the DAUB User Manual, and are intended to be a quick guide
only, to help you get started with creating DAUB graphics. It may be helpful to print this

document. Updates pertinent to the current version are at the end of this file.

Drawing - General Points

With DAUB, the basic drawing technique is the same as for other graphics programs. You
specify a brush, click the mouse in the drawing area of the screen, and drag it wherever
you want colour to appear.

With DAUB, a small red circle appears where you first clicked the mouse (i.e. at the
beginning of the brush stroke), when the brush stroke is completed. This is the selector
circle, and is used for choosing the stroke for further manipulation, at some later stage.
Selecting the stroke is achieved by clicking inside the selector circle with the right

mouse button.

In this version of DAUB, movement of the brush is limited to an area half a brush width
smaller than the drawing area. This area is outlined by a light gray dashed line. When the
cursor is in this area it will change to the 'no go' symbol.

A brush stroke cannot be started in the no go area. Also, if the cursor enters the no go
area while a brush stroke is being drawn, the brush stroke is finished, exactly as if you
released the left mouse button.

The Shift key may be used in conjunction with the mouse, to draw straight lines. Whenever
the Shift key is pressed, while drawing a brush stroke, the program ignores the mouse
until the Shift key is released. This results in a straight line from where the Shift key
was pressed, to where it was released, provided the mouse moves after the Shift key is
released. With the current version of the program, these straight lines will be drawn in
one colour from end to end. (Later manipulation of the brush stroke may result in variable

colour, however).

DAUB also allows the drawing of constrained lines. This means that you can draw a
horizontal or vertical line from where the Shift key was pressed, depending on which is
closest to the cursor. To draw a constrained line, hold down the Shift key, drag the
cursor, and then click the right mouse button (while holding down the Shift key and left
mouse button) .

At this point, you can draw another constrained line by dragging the cursor again, and
pressing the right mouse button again. Any number of joined straight lines can be drawn
like this.

At any time, you can continue drawing freehand by releasing the Shift key, and continuing
to drag the cursor.

Constrained lines will have variable colour, if drawn with a variable colour brush.

By using the ]wtool in the tool column, you can position the caret anywhere in the
drawing area and begin to type in text. The text will appear according to the
characteristics set in the Text Setup dialog box, accessed via the Text main menu item.



Upon pressing <Enter>, the line of text will become an object with its own selector
circle, like the brush strokes.

Exporting Graphics

Graphics produced with DAUB may be 'exported', i.e. transferred to other graphics

programs, in three ways.

1) Any DAUB graphic may be saved as a PostScript file, making it accessable to PostScript
compatible programs such as PageMaker. This is explained in the section Menu Items,
under File. This allows the most accurate reproduction of DAUB graphics in another

application.

2) Any selected group of brush strokes may be copied to the Windows Clipboard as a bitmap,
at whatever resolution and number of colours that your machine displays. This is

also explained in Menu Items, under Edit.

3) Windows allows you to capture the contents of the screen as a bitmap, by pressing the
Print Screen key. This action copies an image of the screen to the Windows
clipboard. You can then paste the screen image from the clipboard while using any

graphics program running under Windows.



Menu Items

The following items are described in the order that they appear in the DAUB menu bar.

The File menu item.

This menu item provides standard file operations plus PostScript options.

File | New

Create a new drawing.

File | Open...

Open a drawing file (e.g. doodle.dob) to make further changes to the drawing.

File | Save

Save the current drawing under the name that appears in the title bar.

File | Save As...

Save the current drawing under a different name.

File | Save (PostScript format)

Save any selected stroke(s) in Encapsulated PostScript (EPS) format. Future versions of
DAUB will include text and other new object types in EPS files.

File | Save As (PostScript format)...

Save in Encapsulated PostScript (EPS) format, but under a different name e.g.

doodle2.eps

File | Print
Print the currently displayed graphic on the printer.

File | Printer Setup
Display the standard Windows printer setup dialog box.

File | Exit
Terminate the DAUB program i.e. quit when you are finished a drawing session.



The Edit menu item.

This menu item provides standard Edit operations, but these do not use the Windows

clipboard since the graphics are not stored as bitmaps.

Edit | Undo

Undo a drawing operation that has only just been completed. Any change made to the drawing

using main menu options Edit, Alter, Move or Outline may be undone this way.

Edit | Cut

Create a temporary copy (invisible) of the selected object(s) and delete it from the

current drawing.

Edit | Copy

Create a temporary copy (invisible) of the selected object(s) for later pasting.

Edit | Copy to Windows clipboard

Stores a bitmap image of the selected object(s) for later pasting in a bitmap-enabled

application, such as PaintBrush or Write.

Edit | Paste

Duplicate the most recently Cut or Copied stroke(s), a short distance from their original

position. This may be done repeatedly, at any time, until the next File | Cut or File |

Copy 1is done.

Edit | Delete

Delete the selected object(s) from the current drawing.



The Strokes menu item.

This menu item gives access to most functions pertaining to brush strokes.

Strokes | Draw Uniformly

This menu item brings up a dialog box which contains various parameters and their default

values.

The brush parameters Red, Green, Blue, Brush Size and Orientation, and the drawing
parameter Delay are for drawing uniformly. This means that the size and colour of the

brush will not change from the beginning of a brush stroke to the end.

Red, Green and Blue are the components of the brush colour.

Brush Size is the diameter of the brush, in pixels.

The Orientation parameter determines whether the brush will stay at the specified angle
(in degrees) during a brush stroke (Constant), or whether it will stay perpendicular to
the path of the brush (Follow curve). The former will result in calligraphy style brush
strokes, while the latter is much like using a round brush, apart from the strokes having
flat ends.

Strokes | Draw Variable

This menu item brings up a dialog box which contains various parameters and their default

values.

The brush parameters Red, Green, Blue, Size and Orientation, and the drawing parameters
Delay, (averaging) Colour and (averaging) Size are for drawing with variation in the brush
parameters. This means that the size and colour of the brush will vary, depending on
changes in the path of the brush stroke. For example, a brush stroke may start red in
colour and quite thin in width, and gradually change to a green colour and a larger width
at the end. In terms of the dialog box, the above example could be set up by setting Red
Initial to 220, Red Final to 0, Green Initial to 0, Green Final to 190, Size Initial to
12, Size Final to 43 and also selecting Length as the path attribute.

Length is the distance along a stroke's path, measured in pixels.

Speed (lo) is the speed at which the stroke is being drawn at any moment, measured in
pixels per 2 seconds. This path attribute is most effective when a stroke is being drawn

very slowly and carefully.

Speed (hi) is the speed at which the stroke is being drawn at any moment, measured by the
distance between successive positions of the cursor. This path attribute is most effective
when a stroke is being drawn smoothly and fairly quickly.

Index is the number of cursor positions that have been recorded by the computer at any
moment, in the stroke being drawn. Thus, it is similar in effect to the Length attribute.
The difference is that changes in the brush parameters are spread over varying distances

on the screen when the mouse is moved slower or quicker.

Curvature is how tightly curled the stroke is at any point.



Slope is a measure of how close to vertical or horizontal the stroke is at any point.
Using this path attribute, a circular movement of the cursor could produce blue brush
marks on the top and bottom, and green on either side, with continuous variation in

between.

In the bottom right corner, averaging values may be specified; Colour for red/green/blue
values and Size for brush size. These drawing parameters are useful for smoothing out the
effect of imperfect mouse movement.

Strokes | Alter Uniformly

This menu item brings up a dialog box which contains various parameters and their default

values.

This is similar to Draw | Uniformly, except that it applies to selected strokes (see
Selectors) that have already been drawn. It can be thought of as an automatic re-draw of
the selected strokes, with the drawing parameters altered. For example, a stroke may be
selected and re-drawn with the brush 80% of its previous size, and with some more red
added in to the colour.

Brush Size % is a percentage of the existing brush diameter, as illustrated in the above
example.

Red Inc is an increment which applies to the red component of the brush colour.

Green Inc and Blue Inc work the same as Red Inc, except that they affect the green and
blue components of the colour, respectively.

Orientation Inc is an increment which is applied to the orientation of the brush,
regardless of whether Const or Follow curve was selected when the stroke was drawn.
A positive value (in degrees) rotates the brush marks clockwise, while a negative
value rotates them anti-clockwise. The brush stroke itself is not rotated.

Strokes | Alter Variable

This menu item brings up a dialog box which contains various parameters and their default

values.

This is similar to Draw | Variable, except that it applies to selected strokes (see
Selectors) that have already been drawn. It can be thought of as an automatic re-draw of
the selected strokes, where further manipulations are applied to the strokes. Thus, for
example, a group of strokes which change from red to green over their lengths might be
altered to go darker where they are tightly curved and remain unchanged elsewhere.

Red, Green, Blue, Size and Orientation are brush parameter increments which can be given
initial and final values under the headings Initial Inc and Final Inc.

One path attribute from the list on the right (Length, Speed etc.) whose range is
specified under the headings Min and Max, may be selected to govern the variation of the

brush parameter increments.

The path attributes for Alter | Variable are described below.



Length is the distance along a stroke's path, measured in pixels.

Speed is the speed at which the stroke was drawn, measured by the recorded distance
between successive brush marks. This is equivalent to the Speed (hi) path attribute
described under Draw | Variable.

Index is the brush mark number, which increases by one for each mark, starting at 1 for
the first mark, and is equivalent to the Index path attribute described under Draw |
Variable.

Curvature is how tightly curled the stroke is at any point, and is equivalent to the
Curvature path attribute described under Draw | Variable.

Slope is a measure of how close to vertical or horizontal the stroke is at any point.
Using this path attribute, a circular brush stroke could be altered to go blue on the top

and bottom, and green on either side, with continuous variation in between.

Strokes | Move

This menu item brings up a dialog box, in which three ways are provided to specify
movement of the selected stroke(s).

The Shift group box lets you specify a shift in the x and y directions (i.e. across and
down) . For example, specifying 200 for the x direction and 100 for the y direction will
shift all the selected brush strokes to the right by 200 pixels and down by 100 pixels.
Negative values go in the opposite directions.

The Scale (%) group box lets you specify scaling in the x and y directions (i.e.
across and down) as a percentage. For example, specifying 200 for the x direction
and 50 for the y direction would make the selected stroke(s) twice as wide and half
as high.

The Rotation group box lets you enter a rotation amount in degrees. E.g. a value of
-30 would rotate the selected stroke(s) 30 degrees anti-clockwise.

The Flip group box lets you flip the selected brush strokes either vertically or
horizontally according to which radio button is selected.

Strokes | Outline

This menu item brings up a dialog box which provides three ways to modify the outline of
the selected stroke(s). The numbers typed in specify how many times the corressponding
operation is repeated.

1) Add brush marks (+) / Remove brush marks (-).

A positive value doubles the number of brush marks in the selected
stroke(s), the specified number of times. This has no visual effect, but
the brush strokes will retain more of the original detail after other

Outline operations have been applied.

A negative value halves the number of brush marks in the selected



stroke(s), the specified number of times. This can be used to remove
'shaky bits' if a stroke has just been drawn using the cursor. Curve Fit
(see below) can then be used to improve the look of the stroke.

2) Smooth.

This operation smoothes the outline of the selected stroke(s) by
averaging the position of the brush mark end points, but will retain the
overall shape of the stroke(s).

3) Curve Fit.

This operation rounds the outline of the selected stroke(s) by adding an
extra brush mark with just the right position and size, between every
pair of existing brush marks. Thus, the curve looks smoother, while
retaining all of its original detail.



The Text menu item.

Text | Enter

This menu item brings up a dialog box which lets you specify various text characteristics
to apply to any text that you type in the drawing area.

The Typeface list box lets you pick a font to use, from all the fonts that you have
installed under Windows. Select a font just by clicking on the name. If you do not select
any font, the most recently selected font will be used. When you first start up DAUB, the
selected font is System.

Height is the height of the font in pixels. The width of the characters will be scaled
automatically to be consistent with the font's default width.

The Weight group box gives you a choice of Normal, Bold or Other. Normal gives the text a
weight of 400, which gives a normal appearance. Bold has a weight of 700 (like this) and
Other is there so you can specify anything from 1 to 999. Fonts have a limited number of
possible weights - the nearest match will be selected. For example, some will only have
400 (normal) and 700 (bold). Hence, specifying 250 will result in the text having a weight
of 400.

The Italic check box lets you turn on (checked) or off (unchecked) italics. This will only
affect TrueType fonts.

The Underline checkbox lets you turn on (checked) or off (unchecked) underlining. This
affects all fonts.

Red, Green and Blue are the RGB components of the colour used to display or print the
text. Any values in the range 0 to 255 may be used, although your monitor will probably
not be able to display the full range of colours.

Text | Alter

This menu item brings up a dialog box which lets you specify various alterations to the
characteristics of any selected text objects.

The Facename list box lets you change the font of all selected text objects to the
selected font.

Height Inc. lets you change the vertical extent of all selected text objects by the
specified number of pixels. A negative number will decrease the vertical extent.

Width Inc. lets you change the horizontal extent of all selected text objects by the
specified number of pixels per character. For proportional fonts, the average change in
character width will corresspond to the specified figure. A negative number will decrease
the horizontal extent.

Weight Inc. lets you change the weight of all selected text objects by the specified
amount. A negative number will decrease the weight. As when entering text, the actual



weights used will depend on what values are available for each individual font.

The Italic check box lets you turn on (checked) or off (unchecked) italics for all
selected text objects. This will only affect TrueType fonts.

The Underline checkbox lets you turn on (checked) or off (unchecked) underlining for all
selected text objects. This affects all fonts.

Red Inc., Green Inc. and Blue Inc. let you adjust the colour of all selected text objects.
Any values in the range -255 to 255 may be used. For example, setting Red Inc to 35 will
increase the red value by 35, and setting Green Inc to -110 will reduce the green value by
110.

Text | Move

This menu item brings up a dialog box which lets you move and/or rotate any selected text
objects.

The Shift group box lets you specify a shift in the x and y directions (i.e. across and
down) . For example, specifying 200 for the x direction and 100 for the y direction will
shift all the selected text objects to the right by 200 pixels and down by 100 pixels.
Negative values go in the opposite directions.

The Rotate group box lets you specify a rotation amount in degrees. For example,
specifying 45 would rotate all selected text objects clockwise by 45 degrees. Negative
values rotate the text anti-clockwise.



The Selectors menu item.

This menu item provides useful short-cuts when multiple objects are to be selected for
manipulation, and the ability to hide or display all the selectors currently on the
screen.

Selectors | Select All

Makes all objects active.

Selectors | De-select All

Makes all objects in-active.

Selectors | Toggle all

Makes all active objects in-active, and all in-active objetcs active.

Selectors | Display Selectors

Make all selectors visible, if they have been hidden.

Selectors | Hide Selectors

Make all selectors invisible, if they are currently visible.



The Options menu item.

This menu item brings up a dialog box which enables you to set miscellaneous options which

can be useful at various times.

The Grid group box allows you to include a grid which displays behind all other graphics
on the screen. The pixel spacing edit box lets you set the number of pixels between each

line of the grid. The Visible check box determines whether the grid is displayed or not.

The Drag 'snap to' check box affects the operation of the drag tool. If checked, the top
left corner of the dotted box always 'snaps' to the grid intersection points (regardless
of whether the grid is visible), thus allowing accurate alignment of strokes or groups of

strokes.

The Screen Refresh group box allows you to alter the way brush strokes are displayed on
the screen (Note: only the way they appear on the screen is changed - for all other
purposes the strokes are entirely unchanged). Any settings affect the currently selected
strokes only, and remain in effect until set differently.

The Every ... brush mark(s) edit box may contain a digit from 1 to 9 - this affects the
amount of detail shown when the stroke is displayed. A value of 1 results in the stroke
being displayed in full detail. A value of 2 results in only half the detail being
displayed, a value of 3 gives a third of the detail, and so on up to 9 which gives only a
ninth of the detail. Reducing the detail also increases the speed at which the strokes are
re-drawn, for example when a dialog box disappears from the screen. This feature is handy
for very detailed and/or large graphics which may be relatively slow to re-draw.

The Frame only check box specifies whether the strokes are filled with colour. If checked,
only the outlines of the brush marks making up the brush stroke will be visible. As well
as being faster to re-draw, this allows you to easily see if any strokes are excessively
detailed, leading to unnecessarily slow re-drawing and unneccessarily large .dob files.



The Tool Column

The following is a brief explanation of the tool column at

The first twelve boxes are a handy way to perform scaling,
operate, click with the left mouse button and hold down as

the operation, hold the <Shift> key down as well. For text

the left side of the screen.

shifting and rotating. To
long as required. To speed up

objects, only TrueType fonts

will behave as expected. For example, most non-TrueType fonts cannot be rotated.

]

Stretches the selected object(s) horizontally.

Shrinks the selected object(s) horizontally.

[]

Stretches the selected object(s) vertically.

Shrinks the selected object(s) vertically.

0

Expands the selected object(s).

Shrinks the selected object(s).

.

Shifts the selected object(s) to the left.

L

Shifts the selected object(s) to the right.

r-==

Shifts the selected object(s) upwards.

Shifts the selected object(s) downwards.



Rotates the selected object(s) anti-clockwise.

{7

Rotates the selected object(s) clockwise.

The next 4 boxes implement the functions under the Strokes | Outline menu item.

A

Adds brush marks to the selected brush stroke(s) once.

A

Removes marks from the selected brush stroke(s) once.

Smooths the selected brush stroke(s) once.

Curve fits the selected brush stroke(s) once.

The next 4 boxes select the 4 different brush types as set in the Strokes | Draw menu

item.

Selects the uniform brush with constant orientation.

Selects the uniform brush with follow curve orientation.

Selects the variable brush with constant orientation.

Selects the variable brush with follow curve orientation.

The last 6 boxes implement the following functions:



Drag and drop the selected object(s).

T

Position the caret and enable text entry.

O

Split the nearest selected stroke at the point closest to the cursor, when the left mouse
button is pressed.

-

Join the tail of one selected stroke to the head of another selected stroke. Nominate the
first stroke by clicking inside the selector circle, then nominate the next stroke in the
same way. The two strokes will then be joined.

7]

Examine the data of the brush mark or text object containing the cursor, when the left
mouse button is clicked.

s

Select a group of objects. Nominate the area enclosing the desired selector circles by
clicking at the top left corner and dragging to the bottom right corner. When you release
the mouse button, all the enclosed red selector circles will turn green.

Note: These last 6 functions may be interrupted with the <ESC> key. For example, if you
select the drag tool you can abort it before dragging anything by pressing <ESC>. The
cursor will revert to the previously selected brush and you are ready to draw again, or

select another tool.



